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OVERVIEW

OVERVIEW

Radeon™ ProRender is a free un-biased rendering plug-in for your visualization
needs in Autodesk® Maya®. Using physically accurate path-tracing technology,
Radeon ProRender can produce stunning photorealistic images of your scene and
provides real-time interactive rendering and continuous effects adjustments to help
create the perfect rendered image. The Radeon ProRender plug-inis fully integrated
into Maya — it supports the Maya lights, materials, and textures and renders your
geometry accurately. Radeon ProRender also comes with a library of materials to get
you started.

This user guide will describe how to use and set up the Radeon ProRender plug-in for
Maya.
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WHAT'S NEW _
What's New in Radeon ProRender for Maya v2.3

e Support for macOS® High Sierra 10.13.3+ using Metal® 2. eGPU devices requires macOS® High Sierra
10.13.4.

e PBR Shader and Denoiser added in the render settings.
e Anadditional control for setting camera exposure to allow adding more motion blur is added.
e Texture gamma settings are now handled correctly.

e Physically based lighting controls greatly improve lighting setups:
o Additional area light shapes include: Rectangle, Disk, Cylinder, and Spheres.
o Light color can be set by temperature, color, texture, or all three.
o Intensity can be set additionally with physical units.

e MayaRemap HSV and Gamma Correct nodes are supported.

e More AOV's have been added for compositing.
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SUPPORTED PLATFORMS _
Supported Platforms for v2.3

Radeon ProRender for Maya v2.3 runs on both GPUs and CPUS. OpenCL™ 1.2 is required for GPUs.

Software

e Autodesk® Maya® 2016 with Service Pack 2
e Autodesk®Maya®2016.5
e Autodesk®Maya® 2017
e Autodesk® Maya® 2018
Operating System

e Microsoft Windows® 7 (64-bit)
e Microsoft Windows® 10 (64-bit)
e macOS®High Sierra 10.13.3+

Join the Discussion

Provide feedback here for all Radeon ProRender plug-ins.

Supported Platforms for v2.1.20.14

Radeon ProRender for Maya v2.1.20.14 runs on both GPUs and CPUS. OpenCL™ 1.2 is required for GPUs.

Software

e Autodesk® Maya® 2016 with Service Pack 2
e Autodesk® Maya®2016.5
e Autodesk®Maya® 2017

Operating System

e CentOS 6.5 (Maya®2016/2017)
e CentOS 7.2 (Maya®2017)
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https://discord.gg/4k8p76N

INSTALL RADEON PRORENDER “

Install the Radeon ProRender plug-in

Radeon ProRender for Microsoft Windows

Download the Radeon ProRender plug-in for Maya for Microsoft Windows®, launch the installer and agree
to thelicense.

f%l Radeon ProRender for Autodesk Maya® Setup - X j}% Radeon ProRender for Autodesk Maya® Setup - X
End-User License Agreement R A D E 0 N
Welcome to the Radeon ProRender for Please read the following license agreement carefully

PRORENDER

Autodesk Maya® v2.3.150 Setup Wizard

UNTIL YOU HAVE CAREFULLY READ AND AGREED TO THE
FOLLOWING TERMS AND CONDITIONS. THIS IS A LEGAL
AGREEMENT  ("AGREEMENT") BETWEEN YOU (EITHER AN
INDIVIDUAL OR AN ENTITY) ("YOU") AND ADVANCED MICRO
DEVICES, INC. ("AMD").

Decumentation

ADVANCED MICRO DEVICES, INC. ~
o The Setup Wizard will install Radeon ProRender for Autodesk END USER LICENSE AGREEMENT
"éJ Maya® on your computer. Click Next to continue or Cancel to
Z exit the Setup Wizard. IMPORTANT-READ CAREFULLY: DO NOT INSTALL, COPY OR USE
wl THE ENCLOSED SOFTWARE, DOCUMENTATION (AS DEFINED
% Main Site BELOW), OR ANY PORTION THEREOF, (COLLECTIVELY "SOFTWARE")
[+ 4
a

I accept the terms in the License Agreement

Back Next Cancel Print Back Next Cancel

Radeon ProRender will check your hardware and software to ensure requirements, before letting you
select your installer settings.

ﬁ! Radeon ProRender for Autodesk Maya® Setup X f;a# Radeon ProRender for Autodesk Maya® Setup — X

Check hardware RADEON Custom Setup RADEON

Check hardware and software... PRORENDER Select the way you want features to be installed.

PRORENDER

Click the icons in the tree below to change the way features will be installed.
Hadware check: OK

SOzt &k SliE S Radeon ProRender] Radeon ProRender for Autodesk
Additional checks:  OK =-ISupport Maya 2018 Maya®

2-|Support Maya 2017

2-|Support Maya 2016 Extension 2

=-|Support Maya 2016

=:| Material Library This feature requires 0KB on your
hard drive. It has 5 of 5 subfeatures
selected. The subfeatures require
688MB on your hard drive.

Next Cancel Reset Disk Usage Back Cancel
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INSTALL RADEON PRORENDER “

Click the Register button —it will take you to an AMD website to obtain an activation key by registering.

f{-# Radeon ProRender for Autodesk Maya® Setup - X ;E%' Radeon ProRender for Autodesk Maya® X

Plugin activation R A D E 0 N

Ready to install... R A D E 0 N

Please register and you will receive your activation key.

PRORENDER PRORENDER

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.
Activation key:

Back o Install Cancel Next Cancel

Register using your information. You will receive your activation key after clicking Request Download.
Enter it into the installer and continue the installation.

AMD Developer: Radeon X

& C | @ www.amdsurveys.com/s:

AMDZ1

Thank you for downloading the Radeon ProRender Add-in for Dassault Systémes SOLIDWORKS®. Please
provide the information requested below to download the add-in.

Contact Information
First Name

AMD

Last Name

ProRender

Email Address

design@amd.com

Country

CANADA v

Please provide a brief description of the product or project where Radeon ProRender will be used

Want fast photo-realistic render of my design |

Stay up to date and informed about the latest tools, events and resources for AMD software technology.
Subscribe to the AMD Developer newsletter and join thousands who are already enjoying this resource
created for developers by developers.

Yes, | would like to receive the Developer newsletter and related AMD Developer Central communications.

Request Download
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INSTALL RADEON PRORENDER n

Click Finish and launch the Maya application to start rendering your images.

f;a;" Radeon ProRender for Autodesk Maya® Setup - X

Completed the Radeon ProRender for
Autodesk Maya® Setup Wizard

Click the Finish button to exit the Setup Wizard.

Radeon ProRender for Autodesk Maya® requires SP6 for
Maya 2016

PRORENDER

Back Cancel
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Radeon ProRender for macOS

Download ProRenderForBlender-XX.dmg. Click to open.

INSTALL RADEON PRORENDER

®®@®
<

| Maya
0D ol Ev % v

Favorites

] Desktop
@ AirDrop
0 Downloads
£ Recents

/2: Applications

RadeonProRender
Maya-2.3.dmg

Open the RadeonProRenderBlenderinstaller.

. RadeonProRenderMaya-2.3

ller

RadeonProRenderMayalnsta

TXT

README.txt
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INSTALL RADEON PRORENDER | 8

Copy and paste the website into browser to obtain the registration key.

Please visit

for the registration key.

Enter the registration key that will be emailed to you.

Registration key:

|
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INSTALL RADEON PRORENDER | 9

Continue through the installation

L N RO ‘& Install AMD Radeon ProRender Maya Plugin

The installation was completed successfully.

Introduction
License
Destination Select
Installation Type

Installation The installation was successful.

Summary

The software was installed.

The Maya modules and shelves will also be installed.

Installed Maya modules and shelves.
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RADEON PRORENDER SET UP

Switching to Radeon ProRender

Launch Maya. You should see menu item for Radeon ProRender, as well as a custom shelf with icons for
key functions and settings.

M Autodesk Maya 2018 - Student Version: untitled”

t Create Select Modify Jisplay Wi WS Mesh  Edit Mesh  Mesh Tools Mesh Display

- E=E>c -gl.krg oS O

& @95 o046 08B
View Sh g Lighting Show Renderer Panels

mMBN LD ZIHEDEDEED @€ D & .

Radeon_ProRender

Select Modify Display [Windows Mesh Edit Mesh Mesh Tools Mesh Display Curves Surfaces Ded

E Ao & C’ No Live Surface

Workspaces »

A : . General Editors
sl e @9 OB
L 4 H. : Modeling Editors

Animation Editors
View Shading Lighting Show Rer

Rendering Editors
=MBN Lo 4 iEEE

Relationship Editors
Ul Elements

Settings/Preferences

: Preferences
QOutliner

Node Editor Hotkey Editor
Playblast Color Settings

Marking Menu Editor
Shelf Editor
Panel Editor

Minimize Application
Raise Main Window

Raise Application Windows
Plug-in Manager
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RADEON PRORENDER SET UP

Under the Plug-in Manager, make sure the Loaded and Auto Load check boxes are ticked next to the
RadeonProRender.mll. Press Close.

M Plug-in Manager — O X

Filter Help

¥ C:/Program Files/Autodesk/Bifrost/Maya2018/plug-ins

Apply To All: Loaded Auto load
bifmeshio.mll v Loaded v Auto load
bifrostshellnode.mll v Loaded ' Auto load
bifrostvisplugin.mil v Loaded v Auto load
Boss.mll Loaded Auto load

¥ C:/Program Files/Autodesk/Maya2018/plug-ins/MASH/plug-ins

NAAC LI aall b mndad 2 Aen lannd e
¥ C:/Program FilesfAMD/RadeonProRenderPlugins/Maya/plug-ins/2018
RadeonProRender.mll v Loaded ' Auto load 0
¥ C:/Program Files/Autodesk/Maya2018/plug-ins/fbx/plug-ins

tfbxmaya.mill v Loaded v Auto load “

You will also be able to set the 3D viewport to the rendered view using Radeon ProRender.

M Autodesk Maya 2018 - Student Version: untitled*

File Edit Create Select Modify Display Windows Mesh Edit Mesh

Modeling E ~ = B X :k (35 =.k G & G

Sl & @9 OO

View Shading Lighting Show | Renderer Panels
mq md =¢q I j = Py (_) E E
® Viewport2.0

Radeon ProRender
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RADEON PRORENDER SET UP

Bring up the Render Settings by clicking on the settings icon on the custom shelf in the Radeon_

ProRender tab or, click the button in the Maya tool bar to bring up the Render Settings.

s Mesh  Edit Mesh  Mesh Tools Mesh Display

o R [ S S
Radeon_ProRender

oL@ 0B

PLIBEDD HEDIQWEE

M Render Settings

Edit Presets Help

Render Layer masterLayer ¥

Render Using Radeon ProRender ¥

Maya Software
Maya Hardware 2.0

About Rade
Radeon ProRender

WEVERY Tate]g E O N

Arnold Renderer
r N\JP.LP'JDER

Radeon ProRender for Maya(R) 2.3.150 (core 1.296)
Copyright (C) 2016 Advanced Micro Devices, Inc. (AMD).
Portions of this software are created and copyrighted
to other third parties.

Main Site  Documentation  Downloads  Community
Knowledgebase  Bug Report

Render Resources
These settings will not affect currently active vi

v Uncertified Device
AMD Radeon (TM) Pro WX 7100 Graphics
CPU

Texture Compression

Completion Criteria

Type Iterations ¥

Iterations 100
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USER INTERFACE

Render Viewports

After setting Radeon ProRender as our renderer, locate the Renderer dropdown on the viewport menu
and select Radeon ProRender. You should see your viewport switch to Radeon ProRender viewport.

M Autodesk Maya 2018 - Student Version: untitled*
File Edit Create Select Modify Display Windows Mesh Edit Mesh

Modeling E ~ B B X

N E 90y 0CTE

View Shading Lighting Show | Renderer Panels Radeon ProRender

k m(PMBR L D LN EE ) & e
Viewport 2.0 []
@® Radeon ProRender

Open the Radeon ProRender drop-down from the viewport menu.

M Autodesk Maya 2018 - Student Version: untitled*
File Edit Create Select Modify Display Windows Mesh Edit Mesh Mesh Tools Mesh Display Curves Surfaces Deform

Modeling v E mEoCc :k (5,3 =.k OIS C‘ ¥ No Live Surface ¥ Sym

TN E 0oy o0 08

View Shading Lighting Show Renderer Panels | Radeon ProRender
k m{MMFRCRN 4 4 Z 1 |HE £ [=] (=1 [*] [T # « Animation cache X (| £ 0.00

Clear animation cache

Viewport Mode » @ globallllumination
directlllumination
directllluminationNoShadow
wireframe
materialld
position
normal
texcoord

ambientOcclusion
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USER INTERFACE

Animation cache

This is used where you can view quick previews of animated object(s) in the scene before rendering the
scene. It stores the first render iteration for each frame of the animation when the frame is first
displayed, so the next time that frame is displayed, it can show the cached version, rather than having to
render it again. This will allow you to scrub through the time-line without having to re-render the cached
frames.

Clear Cache

This is used to clear the animation cache so the render can start over or re-render.

Viewport Mode

This is like render modes which are found in the Render Settings. The render mode can be selected
without opening the Render Settings window.
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USER INTERFACE

Radeon ProRender Settings

Open the Render Settings window.

M Render Settings - O X
Edit Presets Help

Render Layer masterLayer ¥

Render Using Radeon ProRender ¥

Radeon ProRender

About Radeon ProRender

RADEON

PRORENDER

Radeon ProRender for Maya(R) 2.3.150 (core 1.296)
Copyright (C) 2016 Advanced Micro Devices, Inc. (AMD).
Portions of this software are created and copyrighted
to other third parties.

Main Site Documentation  Downloads ~ Community
Knowledgebase  Bug Report
Render Resources
These settings will not affect currently active viewports.
Allow Uncertified Devices

v AMD Radeon (TM) Pro WX 7100 Graphics
CPU

Texture Compression

Completion Criteria

Type

Hours
Minutes

Seconds

Radeon ProRender Tab
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USER INTERFACE

Render Resources

In the Render Resources section select your hardware to render. There are hardware options like GPU
only, CPU only, or CPU and GPU together.

Render Resources

These settings will not affect currently active viewports.

All ncertified Devices
D Radeon (TM) Pro WX 7100 Graphics

CPU

Texture Compression

Completion Criteria

In the Completion Criteria set the amount of time you want your render to complete or set the
Iterations to the desired number of passes you would like Radeon ProRender to renderer to complete to
do before finishing.

Completion Criteria

Type

Hours
Minutes

Seconds

If there are no limits set for time or iterations the render will keep rendering until the user cancels the
render or closes the render window.

Quality
Quality Presets

With Radeon ProRender we have 2 sets of settings, one for the Production rendering and one for the
Viewport rendering. We can use the quality presets, these range from low to medium to high.

Quality Presets

Production Preset Low

Viewport Preset Low
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USER INTERFACE

Render Sampling

Mitchell

Box
Render Sampling - I
riangle

Render samples 1 — :
Gaussian

Filter Mitchell Mitchell

Filter size 1.5000 Lanczos

Max ray depth 5 BlackmanHarris

C\/ Tip: A high number of samples gives you a better render at the cost of render time.

Filter is used to add a filter on a sub pixel level. Several post render image filters are also supported

including:
FILTERS DESCRIPTION
BOX the lowest quality Anti-Aliasing filter

TRIANGLE for sharp results

GAUSSIAN provides blurry Anti-Aliasing

MITCHELL default filter, good for all-round rendering on images with no major high
contrasts

LANCZOS a second good all-round filter

BLACKMAN HARRIS complements the Box and Gaussian filters, and is especially effective for

Wireframe renders, as it makes edges look smoother

May ray depth allows a user to set the number of rays that will be cast and bounced around in the scene
and is especially necessary for refractive surfaces. This is done by increasing the value of the Max Ray
Depth input.

\/ Tip: When using glass or other translucent appearances, use a high number of Ray Bounces to
fully capture all reflections (generally, a good number is 6 unless there are complex, translucent
parts).

The transparency and colour of the object is improved with more ray bounces. Improved image quality
comes at a cost to other factors.
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USER INTERFACE
Advanced Settings

Advanced Settings

Ray epsilon(mm) (
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USER INTERFACE
Globals

¥ Global lllumination

Mode globallllumination

¥' Clamp Irradiance

Clamp Irradiance Value 1.000 .

Global lllumination

Globals provide you with the option of rendering in different modes. This changes the look of the 3D
model in the viewport.You can also set the clamp irradiance value.

¥ Global lllumination
Mode globallllumination
globallllumination
Clamp Irradiance Value directlllumination
Motion Blur directllluminationNoShadow
Denoiser wireframe

Camera materialld

Render stamp position

Environment normal

Ground texcoord

ambientOcclusion

MODE DESCRIPTION

GLOBAL ILLUMINATION | the full scene with full Gl lighting and shadows
DIRECT ILLUMINATION | renders the scene with shadows, but no Gl —gives “harsher” renders
DIRECT ILLUMINATION | directlight, no GI, gives sharper renders without any shadows or semi-

NO SHADOW shadows
WIREFRAME shows the wireframe of the mesh
MATERIAL ID renders the whole scene in non-bordering colors to ease
postwork/processing
NORMAL renders the normals of the scene
TEXCOORD shows the current texture coordinates —UV'd or not

AMBIENT OCCLUSION | standard pass to do anything from showing off your models without
textures to usingit as an overlay for contact shadows, which Gl doesn't

always catch
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USER INTERFACE | 20

Motion Blur

Radeon ProRender’s Motion Blur will make object appear as if it's in motion, in stills as well as animations.

¥ Motion Blur

Camera Exposure

Denoiser

¥ Denoiser
v Enable
Type Bilateral *
Bilateral

Radius

Camera

When working with cameras We have a couple options to choose from. The options can be found in
Render Settings under the Camera section.

¥ Camera
Type Default
» Render stamp Default

»  Environment Spherical Panorama

» Ground Spherical Panorama Stereo

Cube Map
Cube Map Stereo

Radeon ProRender plug-in for Maya User Guide ©2018 Advanced Micro Devices, Inc. Allrights reserved.



USER INTERFACE

Default
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USER INTERFACE | 22

Spherical Panorama

Spherical Panorama will render a 360-degree image that wraps around your scene. This can be used to
create a 360 video of your scene that can be uploaded to YouTube and viewed. Sphere mapping (or
spherical environment mapping) is a type of reflection mapping that approximates reflective surfaces
by considering the environment to be an infinitely far-away spherical wall. This environment is stored as
a texture depicting what a mirrored sphere would look like if it were placed into the environment [1] .
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USER INTERFACE

Spherical Panorama Stereo
Spherical Panorama Stereo will be used to create 360 degree images to be used for VR. As you can see
the Image is split in two and the reason for this is that it is rendering an image for both the Left and Right

eye. Keep the aspect ratio to 1:1 for square pixels.
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USER INTERFACE | 24

Cube Map

For cube mapping you will need to times your resolution width by 6 to get square pixels e.g: 1kres = 6144
x 1024

Cube Mapping is a method of environment mapping that uses the six faces of a cube as the map shape.
The environment is projected onto the sides of a cube and stored as six square textures, or unfolded into

six regions of a single texture.

In most cases, cube mapping is preferred over the older method of sphere mapping because it eliminates
many of the problems that are inherent in sphere mapping such as image distortion, viewpoint
dependency, and computational inefficiency. Also, cube mapping provides a much larger capacity to
support real-time rendering of reflections relative to sphere mapping because the combination of
inefficiency and viewpoint dependency severely limit the ability of sphere mapping to be applied when
there is a consistently changing viewpoint.

Cube Map Stereo

This is pretty much the same as cube mapping except that it splits the render into 12 blocks, 6 for the
Left eye and 6 for the Right. This is for VR. You will need to times your resolution width by 12 to get
square pixels. 1kres =12288 x 1024.

Render Stamp

This will create stamp on final rendered image showing details of hardware and Maya scene information.

¥ Render stamp

Use sh | Tim
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USER INTERFACE | 25

Environment

There are 2 options for Environments: Image Based Lighting and Sky.

¥ Environment

Image Based Lighting Create

Sky Create

Image Based Lighting
IBL is essential for creating real world lighting. It is basically a spherical image (HDR) that is projected onto
a spherical object as your environment to simulate real world lighting.

Enable the IBL by clicking on the create button in the Environment section in Render Settings.

¥ Environment

Image Based Lightin | Create

Sky Create

On the right-hand side, click on the Attribute Editor. Click on the file path and locate your HDRI file go
ahead andload it into your scene.

List Selected Focus Attributes Show Help

RPRIBLShape

RPRIBL: RPRIBLShape

Sample &

File Path

Intensity 1.000
v/ Display

¥ Node Behavior

Caching

10Mp3 ANqUNY

Node State Normal
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Sky

USER INTERFACE

Sky is designed to enable physically plausible daylight simulations and accurate renderings of daylight
scenarios. Under the Environment section in the Render Settings, create the Sky by clicking on the

Create button (same as IBL).

¥ Environment

Image Based Lighting

';:F':

With the RPRSky selected, look in the attribute editor, you will see all the sky properties.

Selected Focus Attributes

RPRSkyShape

RPRSky:

Sample

Sky Properties

Turbidity
Intensity
Filter Color
Ground Color
Ground Albedo
Sun Glow
Sun Disk Size
Sun Position

Altitude / Azimuth
Altitude
Azimuth

Time / Location

RPRSkyShape

Help

v

s
=
=1
[on
C
=
m
m
a
=
5]
-
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USER INTERFACE

Turbidity
Increasing this value will simulate how much dust is in the air by changing the color of the sky to orange.

SRGB gamma

Viewport 2.0 C 512512

Legacy Default Viewport
Legacy High Quality Viewport
® Radeon ProRender

Intensity
This will raise or lower the intensity of the Sky.
Filter Color

This is used to add a tint of color to you Sky. By clicking on the color box, you can select a color you wish
to tint the Sky with.

SRGB gamma
Viewport 2.0 1 512x512
Legacy Default Viewport
Legacy High Quality Viewport
@ Radeon ProRender

a = m@|

< iR
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Ground Color

This is used to select the color for the ground by also clicking on the color box and picking a color.

Sun Glow

Changing this attribute will increase the size of the Glowing halo around the sun disk.
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Sun Disk Size

This attribute is used to increase the size of the sun.

Sun Position

In this drop down, there are 2 options to control the Sky model:

Sun Position  Altitude / Azimuth ¥

P Altitude / Azimuth Altitude / Azimuth

P Time / Location Time / Location

Sofar, the settings are on the Altitude/Azimuth setting. By switching to Time/Location, that the
Time/Location section is available and the Altitude/Azimuth section is now greyed out and is no longer
available.

Altitude and Azimuth

These two attributes determine where the Sunis in the Sky. You will notice that if you lower or raise the
altitude value you will be able to simulate a sunset or sunrise.

Sun Position Altitude / Azimuth ¥

¥ Altitude / Azimuth
Altitude 45

Azimuth 0.000

Radeon ProRender plug-in for Maya User Guide ©2018 Advanced Micro Devices, Inc. Allrights reserved.



USER INTERFACE | 30

e - - Na

Azimuth

This attribute will change the placement of the sun by rotating the sun on the Y axis in the scene.

Time/Location

This used to create lighting for any place in the world at any given time. To control the Sun position, the
user has a set of options like Hours, Minutes, Seconds, Month, day, year, latitude and longitude, that
allow the user to simulate a precise sun position.

Tick the checkbox if you would like to enable Daylight savings. We are also able to automatically Set
Time To Now simply by click on the button. It will use the Time from your System Clock and set it to that.

Latitude and Longitude work very like Altitude and Azimuth in that they determine where the sunisin
the sky at any location.
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Time / Location

Year 2016

Month

Day

Hours

Minutes

aylight Saving
Set Time To Now

Latitude

Longitude

Get Location

Get Location

Clicking on the Get Location button will display a map to pick any location on the planet.

1. You canuse the mouse to pick a place anywhere on the map. You will create ared dot.
2. You canuse the search option to more precisely find a certain city in any country.

M Radeon ProRender Location Selector X

Search

Cancel

\/ Note: Most of the attributes for Sky are keyable for an artist to animate a full day cycle.
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Ground

¥ Ground
Use Ground
Ground Height

Ground Radius

Strength

Roughness

Radeon ProRender plug-in for Maya User Guide ©2018 Advanced Micro Devices, Inc. Allrights reserved.



USER INTERFACE | 33
Tone Mapping

Tone mapping is a technique used in image processing and computer graphics to map one set of colors
to another to approximate the appearance of high-dynamic-range images in a medium that has a more
limited dynamic range.

With Radeon ProRender we can use the Tone Mapping section in the Render Settings to select between
five different tone mapping types: Linear, Photolinear, Autolinear, Max White and Reinhard02. You can
also adjust display and texture gamma.

Tone Mapping

ACEIER R EVERUTSNT

Display Gamma 2 l

Texture Gamma 1.000 .

Linear

Photolinear
Reinhard02

White-balance

Enabled

CC"C”. _

Linear

Raise or lower the brightness of the scene by increasing or decreasing the Scale value.
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Photolinear

This is based on real-life camera settings. ISO is film speed — the higher the value, the more lightis let
into the image. F-Stop is aperture width, and follows regular camera settings — the smaller the number,
the wider the aperture, and the more light will be transmitted to the film. Shutter Speed is how long the
shutter stays opento letin light, also known as exposure.

"  Photolinear

Sensitivity  1.000

1,000

Reinhard0?2

This is aimed at adapting the high dynamic range of real world lighting to your screen.

\/ Note: It does this by letting you set values for Burn, Post Scale and Pre Scale Pre Scale and Post
Scale work together, this means that if you tweak one, you'll probably have to tweak the others.

Pre Scale controls the brightness of darker areas (i.e. shadows). Post Scale controls the final brightness
of the image and Burn is used to tweak the brightness of highlights in your image based onits darker
areas.

*  Reinhard0?
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White-balance
White Balance follows the basic settings of a digital camera —lets you set the color temperature of the

lightin the image.

¥ White-balance

v Enabled

Render Passes (AOV)

We are also able to create render passes that can be saved into a single EXR file. This can be done by
firstly checking all the render passes you would like to render in the Render passes tab in your render

settings.

*  Render Passes (AOV)

Displayed In Render View Color

orld Coordinate
U
Material Index

ric Normal

g Marmal

Torender a pass through your render viewer or Radeon ProRender viewport you will need to select the

render pass in the Displayed in Render View dropdown menu.
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For you to render the output file as an EXR file You will need to follow these steps.

1. Make sure your Project is set correctly.

2. Intherender settings, common section locate the file output tab. Give your output file a name by typing it
into the File name prefix box.

3. Inthe Image format dropdown menu select EXR as the file type.

¥ File Output

File name prefixz Car shar:le|

Image format:

Frame/Animation ext:  name.ext (Single Frame)

Use custom extension

Version Label:

Initiate a render and once it finishes open it in any image editing software. You will notice that the EXR file
when opened contains multiple layers for all the render passes you have selected.

&

} Material ID
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Working with Lights
Initial Lighting of a Scene

Go to your Render Settings window, select the Radeon ProRender tab and navigate to the Environment
dropdown section. In the Environment dropdown click on the Create button next to Image Based
Lighting. This will provide lighting of the scene reflective of the surrounding environment.

*  Environment

Image 1 Lighting Create

Sky Create

Emissive Material Lights

With Radeon ProRender, we can also use objects as lights by applying an Emissive material to any 3d
object in the scene. We will be adding an emissive material to a lantern shape in the scene.

103p3 9ke1 / Xog PUUEY)

MO 4 P Pl M
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Go to your Hypershade Editor and from the Radeon ProRender materials create an RPRMaterial. You
canrename and change it from Diffuse to Emissive from the Type dropdown.

Untitled_1

Light_Emissive
® . o= RPRMaterial1SG

Message - = Light_Emissive

Out Color RPRMaterial:  Light_ ve Presets

Out Transparency Message
Color Partition Sample .

Disable Swatch Dag Set Members
Normal Map Surface Shader S

Refractive Index =
Attributes

Rotation o
Roughness

Roughness X
Roughness Y Emission

Swatch Iterations
Ward
Transparency

Watts Per Sgm
Normal Map
Node Behavior

uuID
Extra Attributes

In the emissive materials properties, under the emission section,you can change the color and the watts
per sgm (brightness) of the light. Set your Emission to 5 and your color to a slightly yellow white color.

Light_Emissive

RFRMaterial: Light_Emissive Presets

Sample

Swatch properties
Type Emissive

Common Material Attributes

Emission

Watts Per 5':||'I'I
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Select your geometry to apply the material. We will be applying the material to certain faces on the
lantern.

Thenright click and hold over your light Emissive material in the Hypershade and select Assign Material
to Viewport Selection.

Assign Materia: To Viewport Selection
LIYIIL_EITSpIve
Faint Assign Shader .
S . = RPRMaterial1SG

Select Objects with Material

Yl

=]
Refresh Swatch Mes Remove Material Soloing b — .

solo  Color
Qut Transparencv Message
Light_Emissive... .
Partition

Dag Set Members

Frame Objects with Material

Remove Material Override From *

Inputs N Surface Shader

Qutputs L4
Rename

Toggle Swatch Size

Toggle Selection Swatch Size

Edit Custom Attribute List
Show All Attributes

Add Attributes...

Delete Attributes...

Help on "RPRMaterial’

LI 1o oy
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The rendered image will not have emissive lights

size: 960 x 540 zoom: 1.000 (Radeon ProRender)
Frame: 1 Render Time: 3110 Camera: perspShape
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Portals

Portals are used to limit the amount of light being cast in scene. Using portals allows a user to allocate an
exact point from where the light should come from when using a IBL or Sky instead of casting light over
the entire scene. This is only useful when lighting interior scenes.

Here we have aninterior scene that is being lit by using the Sky. You can see that the light is being cast
through all the windows.

pel

Rerfresh Object List

Load Attributes CopyTab

MOl 4 D P PP

To activate the portals, create a Plane and place it in front of your windows.

Select the sky widget from the viewport or from the outliner. Navigate to the Sky attributes panel on the
right hand side and locate the Portals dropdown. We can then select the Object As Portal dropdown and
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find the pPlanel object we created. Make this your portal. If itis not in your list hit the Refresh Objects
List button.

Portal pPlanel

Object as Portal: pPlaneShapel v

Rerfresh Object List

Hit render and you will notice that the light is now only being cast from the plane instead of the entire
scene.

This feature willincrease rendering performance.
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Working with Cameras

When working with cameras We have a couple options to choose from. The options can be found in
Render Settings under the Camera section.

¥ Camera
Type Default
¥  Render Passes (AQV) Default

Displayed In Render View >Pherical Panorama

Spherical Panorama 5tereo

Cube Map

Cube Map Stereo

When the camera type is set to default, it will render out the usual flat image to the resolution you set in
your render settings. This is what you will probably use the most when rendering.

Depth of Field

With your camera selected, go to the Attribute Editor by clicking Windows > General Editors > Attribute

Editor or by clicking the Camera attribute n button.
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M Autodesk Maya 2017: untitled® --- carneral

File Edit Create Select Modify Display | Windows Mesh Edit Mesh Mesh Tools Mesh Display Curves  Surfaces  Deform

Modeling b

T, o
= |
oA d

! Shading
m T M|

E=mEoc

Qo

Lighting Show R

S £ |EIE =

Workspaces

General Editors
Modeling Editors
Animation Editors
Rendering Editors
Relationship Editors
Ul Elements
Settings/Preferences
Cutliner

Mode Editor
Playblast

ve Surface

= Attribute Editor

Channel Box / Layer Editor
Content Browser

Tool Settings

Hypergraph: Hierarchy
Hypergraph: Connections
Viewport

Asset Editor

Attribute Spread Sheet

(=N N

Radeon_

Minimize Application Component Editor

Raise Main Window Connection Editor

Raise Application Windows Channel Control
Display Layer Editor
File Path Editor

Mamespace Editor
Script Editor
Command Shell
Profiler

Evaluation Toolkit

[+]1E3
Locate Depth of Field. Check the box to enable DOF.
¥  Depth of Field

v Depth Of Field

Focus Distance

F Stop

Focus Region Scale

Setinyour focus distance to determine how far you want your camera to focus from the lens to the
object. F-stop will determine how much blur will be added to the render. The higher the value the less
amount of blur you will see.
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VR Cameras

When working with cameras, there are a couple options to choose from. The options can be found in
Render Settings under the Camera section.

When the camera type is set to default, it will render out the usual flat image to the resolution you set in
your render settings. This is what you will probably use the most when rendering. The Spherical
Panorama Stereo camera type provides you with a 360-degree split (over and under) stereoscopic image
(one part for each eye) output suitable for viewing through VR devices.

Spherical Panorama Stereo will be used to create 360-degree images to be used for VR. As you can see
the Image is split in two and the reason for this is that it is rendering an image for both the Left and Right
eye. Keep the aspect ratio to 1:1 for square pixels.
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Working with Materials

Included within the Radeon ProRender install is the addition of Radeon ProRender materials to the Maya
material library for you to use.

Display the Material Library

Click on the Hypershade Button in the Radeon ProRender shelf or use the Hypershade Button next to
the Render Settings button.

M Autodesk Maya 2017: untitled®
File Edit Creat Modify Display | Windows | Mesh  Edit Mesh  Mesh Tools  Mesh Display

Modeling E=E>Cc

Workspaces
General Editors

Modeling Editors

Animation Editors
Shading Lighting Show R View Shading Light

[ T CI FA EEE

Rendering Editors
= Relationship Editors £d Render View gAY
Ul Elements Render Settings
Settings/Preferences ) Hypershade
F° Render Setup
Light Editor

Custom 5tereo Rig Editor

Qutliner

MNode Editor
Flayblast

Rendering Flags
Minimize Application g :
Raise Main Window Shading Group Attributes
wdlse [V v i3h

Raise Application Windows Hardware Render Buffer
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Once the Hypershade Editor window is open, navigate to the Radeon ProRender materials and select an
RPR Material. And middle click and drag it onto your object in the viewport.

M Hypershade

File Edit Wiew t abs Window Options Help

Materials

lambert1 particleClo...

* Favorites

") RPR Blend Material

") RPR Layered Material

RPR Material
ial
‘PR Transparent Material

PR Uber Material

lendering
Radeon ProRender
Surface
Volumetric

¥ Shader
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Radeon ProRender Material Library

Radeon ProRender Materials Breakdown:

MATERIALS DESCRIPTION

RPRBLEND used to blend 2 or more materials together
RPR LAYERED
RPR MATERIAL

RPR SUBSURFACE used for surfaces that does not reflect light off the surface like a mirror or
water, but penetrates it alittle, like candles, milk, skin or fruit, like grapes

RPR TRANSPARENT used to generate only transparency. Will be used with Blend material to
make more advanced materials such as meshes and layered shaders

RPR UBER combines several inputs to generate one big shader, alleviating the need to
combine and group many shader-nodes together

RPR VOLUME used for streetlights at night, fog or mist

The installer also adds the following Maps:

MAPS DESCRIPTION

RPR TEXTURE
RPR ARITHMETIC
RPR BLEND VALUE
RPR BUMP
RPR CHECKER
RPRDOT
RPR FRESNEL

RPR FESNEL-SCHLICK

RPR GRADIENT

RPR INPUT LOOKUP

RPR NOISE

Radeon ProRender plug-in for Maya User Guide ©2018 Advanced Micro Devices, Inc. Allrights reserved.



MATERIALS | 49

RPR NORMAL
RPR PASSTHROUGH

RPR DISPLACEMENT

Radeon ProRender Material Browser

The installer package adds complex materials that uses the materials above in conjunction with maps
and node connections to create a large library of pre-configured materials for you to use.

In the viewport, open the Radeon ProRender Material Library.

M Autodesk Maya 2017: untitled*

File Edit Create Select Modify Display Wir s Mesh Edit Mesh  MeshTools Mesh Display Curves  Surfac Generate Radeon ProRender

Modeling v | @ > c 2k [ek S G Oy CY Gy O o Live Surface ¥ ® Annie Yu

Radeon_ProRender Arnold Bifrost MASH

he Radeon ProRender material library

Shading Lighting Show Renderer Faneis

Im"“""IL._,.-' 0 [EIB D EEE

Double click the material to import into the Hypershade.

M Radeon ProRender Material Browser - [m] X

Categories Materials

& Composites a e R A D E O N

Concrete e
Emissive

Fabric

Fur

Glass .

Ground ~ B E y ol

Jewels v

Leather Carbon Fiber Carbon Fiber Semi Glo... Carbon Fiber Glossy
Liquid

Metallic Paint

Car Paints

Metals

Extended Metals
Paint [

B

v/ Import images

Plastic

Porcelain Carbon Fiber Glossy C...

Preview
Precious Metals

Roofing

Rubber

Transparent Plastic

Wood

To import a material, dc
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In the Hypershade, you will see the material, and various nodes used to create that particular material.

M Hypershade - O X

File Edit

Show 3 € ¥ Shader Ball ¥ Off

Materials

|Glass_Solid... | Material_30 | Material_31| lambert1 |particieClo... (’

(afxln}

Untitled_1

raderfx Shader

Presets

| Shader
- Hair T hader
Lambert
d Shader Mormal Map

S Fui

® Light Fog
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Assigning Basic Materials

Click on the object in the viewport. Right click the material node in the Hypershade Editor and select
Assign Material to Viewport Selection.

M Hypershade

File Edit Create Tabs Gra

O] CH O] NOMO)

Materials

RPRMaterial1| lambert1 particleCo...

L

Untitled_1

Assign Material To Viewport Selection

RPRMateriall

A rerial15G
iMstenIggy < ? RPRMaterial: RPRMateriall Presets

Refresh Swatch M Remave Materi

R Texture £ Color .
Sample
Arithmetic ansparency s LT

r
ez RPRMaterial
Swatch properties
Frame Objects with Material
Type Diffuse
Remove Material Override From  *

Common Material Attributes

R —

Outputs

Rename

Emission

Help on "RPRMaterial
Mormal Map

Assign a IBL to your render settings and do a test render. You will notice that the RPRMaterial is set by
default to Diffuse which will give you a matte shaded finish.
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In the material attributes under Swatch Properties > Type you are able to switch between a range of
different material types.

Untitled_1 +

RFRMaterial1

o= aterial15G

RPRMaterial: RPRMateriall Presets

Message

Qut Color!
0 e Sample
Qut Transparency ge

Color
jizable Swatc
Disable Swatch Swatch properties
Normal Map
Type | Diffuse

Common Material Ath Diffuse

Refractive Index
Rotation

Roughness Color Microfacet

Roughness

Swatch lterations -
Emission

Transparency

Watts Per Sgm
Ward

Normal Map

Change your material Type to Microfacet.
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You will notice that in you Radeon ProRender material attributes there are a couple more options that
become available when changing the material type. We can change the roughness to make the material

more shiny or we can change the index of refraction. Set your roughness to 0.1 to see the material with
some reflectivity.

Material type set to Reflect, this will only give you the raw reflection of the scene and will most likely be
used in a blend material:
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Material type set to Refract, this will give you the raw refraction of the scene and will also most likely be
used in a Blend material:

—

Material type set to Microfacet Refraction, this material will simulate an opaque material like the paper
on a Chinese lantern. It allows light to pass through it. You can change the amount of light that passes
through the material by lowering the IOR(index of refraction) intensity.
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Material type set to Emissive, this material will emit light from geometry which has the emissive material
appliedtoit:

Material type set to Ward, this material will give you more of a metal texture, it has a anisotropic quality
by means of roughness X and Y. Setting the X and Y values differently will give you different reflections
(stretched).

Default Roughness Y setto 0.1, Xsetto 0.5
Roughness Xsetto0.1Y setto 0.5 Rotation set to 45

) // '\\\ // '\\\
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Using Maya Materials

Like the Standard Lights many of the Standard Materials are not supported by Radeon ProRender. Many
of these materials simulate a physical effect on the surface of an object which is not required when using
a physically based material and ray-tracing renderer.

Although Radeon ProRender will attempt to render the Maya Standard Materials, the result may be
unpredictable as the renderer will only process the materials attributes that have a counterpart in the
real world.

The specific models supported by Radeon ProRender include:

e Blinn

e Metallic

e MultiLayer

e Oren-Nayar-Blinn
e Phong

e Strauss

e Translucent
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Saving

To save your rendered images you have 2 options. You can save the image directly from your render view
window under File > Save Image. Remember to consider that in the save image options you must set
what color management you would like to save your image in.

M Render View — O X

File View Render IPR Options Display Help

I¥), Radeon ProRender

Open Image...

Save Image...

Keep Image in Render View

size: 512 x 512 zoom: 1.000 (Radeon ProRender)
Frame: 51 Render Time: 0:12 Camera: perspShape
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Then we can also save the rendered image by using the File Output section in the Render Settings (this

is dependent on having your project set correctly). This is what you would use to render out batch
animations and store the files in your project directory.

M Render Settings

Edit Presets Help

Render Layer masterLayer 7

Render Using Radeon ProRender

Common

Image size: 260 x 540 ( % 7.5 inches 72 pixels/inch )
*  File Output
File name prefi  Lighthouse

Image format:  JPEG (jpal

Frame/Animation ext: name.ext (Single Frame)

Diagnostics and Trace Files

To allow developers to track down issues with the plug-init is often necessary to provide trace files that
log what happened to the plug-in and where the plug-in may have had problems.

On the top-level menu select Radeon ProRender > Debug > Enable Tracing to activate the diagnostic
tracing feature.

ache | Radeon ProBender Arnold Help

| Q2

Import sraphics ey

Export

Debug

Enable Tracing

Open Trace Folder
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By default, the tracingis not set. This is to save space and assist performance. If you encounter a

problem, it is advisable to:

e Enable tracing.

e Reproduce the problem.

e Locate the tracefiles.

e Zipthe tracefilesinto a single .zip file.

e Complete a bugreport via this link http://maya.radeonprorender.com/support/tickets.

SAVING

¢ [fyoudon't have an account you will need to set one up.

e Describe the procedure or steps you used to reproduce the problem.

e Attach a sample scene of where the error occurred.
e Attach the trace files .zip to the bug report.

Once you have captured the trace file, repeat the selection above to disable the tracing feature. This will
stop the plug-in from recording all events and using up your valuable disk space in the future.

You will see in the top-level menu and option to Open Trace Folder. Select Radeon ProRender > Debug >

Open Trace Folder.

che | Radeon ProBender | Arnold Help

Export
Import

Debug v Enable Tracing

Open Trace Folder

The directory location of the trace files is:

<%user%>/AppData/Local/RadeonProRender/Maya/Trace/YY.MM.DD-HH.MM

You will see there are a number of files generated by the plug-in's diagnostics system. Inside this

directory are the following files:

Fay
Mame Date modified

|j rprirace_data.bin
|j rprirace_playl.cpp

I rTrace_player.c
P player.cpp
| | rprTrace_player.h

|:| rprirace_playList.h

rd
r=]

/2017 1:37 PM
/2017 1:37 PM
/2017 1:37 PM
/2017 1:37 PM
/2017 1:37 PM
/2017 1:37 PM

rd
J*=]

rd
=]

rd
Jr=]

L=y B = [N = R = R = /= 1
rd
P

rd
r=]

|:| rprirace_variables.h

nie * AppData » Local *» RadeonProRender » Maya » Trace » 17.06.29-13.37

Type

BIM File
CPP File
CPP File
H File
H File
H File

Size

DKB
O KB
IKB
2 KB
1KE
1KE
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Itis advisable to zip the top level directory YY.MM.DD-HH.MM by right clicking the directory and sending
it to compressed zip file.

17.06.29-13.37 0/29/2017 1:37 P File fo|der
Open
Open in new window
Pin to Quick access

Ea Scan with Windows Defender...

Share with p
Restore previous versions

Include in library >
Pin to Start

Add to archive...
Add to "17.06.29-13.37.rar"
Compress and email...

Compress to "17.06.29-13.37.rar" and email

Wil G G G

Send to > B Bluetooth device
Cut : Compressed (zipped) folder
Copy I Desktop (create shorteut)
|Z] Documents
Create shortcut B F eent
ao Fax recipien
Delete ] o
1 Mail recipient
Rename
E TeamViewer
Properties [

You can then attach this .zip file to any bug report you lodge.
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